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For information, contact Elecard. 

More information can be found at: https://www.elecard.com 

For Technical Support, please contact the Elecard Technical Support Team: tsup@elecard.com 

 

Elecard provides this publication “as is” without warranty of any kind, either expressed or implied. 

Whilst we make every attempt to ensure the accuracy and reliability of the information contained in the 

document, it may still contain technical inaccuracies or typographical errors. We would appreciate any 

feedback about inaccuracies or errors you may find when examining the documentation. While every 

precaution has been taken in the preparation of this document, the publisher and author assume no 

responsibility for errors or omissions. Nor is any liability assumed for damages resulting from the use 

of the information contained herein. Changes are periodically made to the information herein; these 

changes will be incorporated in new editions of the publication. Elecard may make improvements and/or 

changes in the product(s) and/or the program(s) described in this publication at any time. 

Other company, product, trademarks, and service names are trademarks or service marks of other 

companies or corporations. 

Copyright © 2006-2023 Elecard. All rights reserved. 
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1. Introduction 

1.1 Preface 

Elecard Video Quality Estimator is a powerful tool designed for professionals and prosumers in the video 

compression field. 

Elecard Video Quality Estimator allows the user to calculate objective video quality metrics, such as 

PSNR, APSNR, SSIM, DELTA, MSE, MSAD, VQM, NQI, VIF, VMAF and VMAF phone to compare 

two streams with referenced RAW data, analyze differences, and identify the code portion causing the 

quality change.  

1.2 Describing Elecard Video Quality Estimator 

The following section defines the specification and features of Elecard Video Quality Estimator. 

1.2.1 Supported Video Formats 

• MPEG-1 Video stream, 

• MPEG-2 Video stream, 

• AVC/H.264 Video stream, 

• HEVC/H.265 Video stream, 

• VVC/H.266 Video stream, 

• VP9 Video stream, 

• AV1 Video stream, 

• AVS3 Video stream, 

• MPEG-2 Transport Stream (MPEG-1/2, AVC, HEVC), 

• MPEG-2 Program Stream (MPEG-1/2, AVC, HEVC), 

• AVI file container (MPEG-1/2, AVC, HEVC), 

• MP4 file container (MPEG-1/2, AVC, HEVC, VP9, AV1), 

• MKV file container (MPEG-1/2, AVC, HEVC, VP9, AV1), 

• WebM file container based on MKV (VP9, AV1), 

• IVF file container (VP9, AV1), 

• FLV file container (AVC, HEVC), 

• MXF file container. 

1.2.2 Supported Raw Formats 

• I444 

• I422 

• IYUV 

• NV12 

• NV21 

• P444 

• RGB24 

• RGB32 

• UYVY (Y422, UYNV, HDYC) 

• V210 
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• V400 

• V444 

• Y42B 

• YUY2 (YUNV, V422, YUYV) 

• YV12 

• YV16 

1.2.3 YVYUMetric Types 

• PSNR – Peak Signal-to-Noise Ratio. 

• APSNR – average values of PSNR results calculated for a sequence and based on mean values 

of MSE results.  

• VQM – Video Quality Measurement Techniques – a metric designed to calculate video quality 

and measure perceptual effect of video distortions. 

• SSIM – Structural SIMilarity. This metric is based on measuring three components (luminance 

similarity, contrast similarity and structural similarity) and combining them into result value. 

• DELTA – the value of this metric is the mean difference of the color components in the 

correspondent points of image. 

• MSE – Mean-squired-error based metric. 

• MSAD – the value of this metric is the mean absolute difference of the color components in the 

correspondent points of image.  

• NQI – New Quality Index - is a metric designed to calculate video quality by combining three 

components: correlation loss, luminance and contrast distortion. 

• VIF - Visual Information Fidelity - is a full reference image quality assessment index based on 

natural scene statistics and the notion of image information extracted by the human visual system. 

• VMAF – Video Multimethod Assessment Fusion is an objective full-reference video 

quality metric developed by Netflix in cooperation with the University of Southern California.  

• VMAF phone – a metric designed to predict the quality of videos displayed on mobile phones. 

1.2.4 Features 

• Calculation of video quality metrics (PSNR, APSNR, MSAD, MSE, SSIM, DELTA, VQM, NQI, 

VIF, VMAF and VMAF phone); 

• Selection of ROI (region of interest) for metrics calculation; 

• Display of essential statistics of encoded streams;  

• Automatic selection of the similar first frame in two streams for analysis synchronization; 

• Comparison of two encoded frames from different streams with a reference stream; 

• Sharing comments between application instances and/or applications of Elecard StreamEye Studio 

set; 

• Synchronization between applications of Elecard StreamEye Studio set (Binding mode); 

• Bit distribution display; 

• Command line tool;  

• Saving data into CSV or text files; 

• Display of comparison results in graphs: quantizer, frame size, bit allocation etc. 

https://en.wikipedia.org/wiki/Video_quality
https://en.wikipedia.org/wiki/Video_quality
https://en.wikipedia.org/wiki/Netflix
https://en.wikipedia.org/wiki/University_of_Southern_California
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1.3 Using the Guide 

1.3.1 Purpose 

This guide is intended to help the user utilize Elecard Video Quality Estimator. It describes the Video 

Quality Estimator GUI, settings and functions and provides instructions for using Video Quality 

Estimator. 

1.3.2 Topics Covered 

The following lists the topics covered in this document: 

• Section 1: Introduction – provides a general overview of Video Quality Estimator and describes 

the purpose of the document and its contents. 

• Section 2: Getting Started – describes how to install, uninstall and run Video Quality Estimator. 

• Section 3: Using Elecard Video Quality Estimator – describes the Video Quality Estimator 

GUI, provides instructions for comparing video streams and viewing the results of comparison. 

• Section 4: Command Line Tool – covers advantages and features of Command Line Tool, and 

describes a list of commands applied for automatic analysis of media streams. 

1.3.3 Related Documentation 

For additional information, review the following documents: 

• ISO/IEC 11172-2 for MPEG-1 video 

• ISO/IEC 13818-2 for MPEG-2 video 

• ISO/IEC 14496-10 for AVC/Н.264 video 

• ISO/IEC 23008-2 MPEG-H Part 2 

• ITU-T Recommendation H.265 

• H.266 Versatile video coding 

• A VP9 Bitstream Overview for Google VP9  

• AV1 Bitstream & Decoding Process Specification  

• AVS3 (Information Technology Intelligent Media Coding (T/AI 109.2 — 2021) by Industry 

Alliance Standard) 

1.4 System Requirements 

1.4.1 Software Requirements 

• macOS 10.13 High Sierra — Mac OS 13 Ventura. 

1.5 Licensing and Technical Support 

By installing, copying, or otherwise using the SOFTWARE PRODUCT or any UPDATES, you agree to 

be bound by the terms of the "Elecard" End-User License Agreement (''EULA''). This EULA is a legal 

agreement between you (either an individual or a single entity) and Elecard for the "Elecard" software 

product(s) accompanying this EULA, which include(s) computer software and may include "online" or 

electronic documentation, associated media, and printed materials (''SOFTWARE PRODUCT''). 

For technical support, please contact Elecard Technical Support Team: tsup@elecard.com 

For sales and licensing information, contact Elecard Sales Department: sales@elecard.com 

mailto:tsup@elecard.com#_blank
mailto:sales@elecard.com#_blank
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1.6 Activating Elecard Video Quality Estimator 

1.6.1 Sentinel License Protection 

Make sure that Sentinel License Manager software has been installed on your computer. License 

Manager is provided within the product installation pack for Windows OS and macOS and installed 

automatically. 

License Manager is provided as a separate installation pack for Linux OS and should be installed 

manually. 

Please note, macOS reinstallation will make the activated product license invalid. 

To check that License Manager is properly installed, go to Sentinel Admin Control Center at 

http://localhost:1947. If you see your license information, the installation is successfully completed. 

 
Figure 1. The License Manager with license information 

License Manager allows configuring, controlling, monitoring, and looking through a list of available 

licenses. For more details on License Manager operation click the Help tab.  

Note, each page contains the Help tab related to this page only. 

You can activate Elecard Video Quality Estimator offline via following steps: 

For Elecard Video Quality Estimator activation, a C2V (client-to-vendor) file should be created. To 

create the C2V file follow the steps: 

1. Open the Application (VideoQuest) tab and select Preferences in the drop-down menu. 

2. A dialog window should open. Open the License tab. 

3. Select HASP-SL for PC-based or HASP-HL for dongle-based activation in the Offline activation 

with license files field. Note, if you select a PC-based (HASP-SL) activation, full featured 

activated Elecard Video Quality Estimator will run only on this particular hardware. If you have 

Elecard dongle, plug it into a free USB port on your computer and select dongle-based (HASP-

HL) activation. It will be possible to use Elecard product on any hardware with the dongle 

plugged in.  

http://localhost:1947/
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Figure 2. Offline activation with license files 

4. Click the Collect license information button. The Save File dialog box should open. Click Save 

and save the C2V file to a required directory. Send the saved C2V file to Elecard Sales at 

sales@elecard.com. 

 

 
Figure 3. Creating a C2V file: License tab 

5. After receiving the V2C file containing license information back from Elecard Sales save the 

received file to a required directory. Open the Application (VideoQuest) tab and select 

Preferences in the drop-down menu again. Open the License tab and click Apply license update 

(see Figure 4). The file selection dialog box should appear. Choose the received V2С file and 

click OK. Your application is successfully activated. 

mailto:sales@elecard.com
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2. Getting Started 

The following section details the procedures for installing and running Elecard Video Quality Estimator. 

2.1 Installing Elecard Video Quality Estimator 

Elecard Video Quality Estimator is supplied as part of Elecard StreamEye Studio or as a standalone 

application. The application is installed via Elecard StreamEye Studio or Elecard Video Quality 

Estimator installer.  

Depending on the purchased product or version, the installation file is located: 

• Applications → Elecard StreamEye Studio 2023; 

• Applications → Elecard Video Quality Estimator 2023. 

The console is located in: Users → bin → VQconsole → videoquest-cli. 

The documents are located in: Library → Application Support → Elecard → Video Quality Estimator 

2023 → Elecard Video Quality Estimator 2023.pdf. 

2.2 Uninstalling Elecard Video Quality Estimator 

Elecard Video Quality Estimator can be uninstalled as part of Elecard StreamEye Studio or as a 

standalone application. To uninstall the application in macOS, move the required application to the trash 

icon. 

Elecard StreamEye Studio or Elecard Video Quality Estimator applications are located in the 

Applications folder: 

• Applications → Elecard StreamEye Studio 2023; 

• Applications → Elecard Video Quality Estimator 2023. 

The console is located in: Users → bin → VQconsole. 

The documents are located in: Library → Application Support → Elecard. 

2.3 Running Elecard Video Quality Estimator 

To run Elecard Video Quality Estimator, click Applications → Elecard StreamEye Studio 2023 → 

Elecard Video Quality Estimator 2023 

To run Elecard Video Quality Estimator, click Applications → Elecard Video Quality Estimator 2023 



Elecard Video Quality Estimator 2023 

User Guide                                                     
__________________________________________________________________________________ 
 

__________________________________________________________________________ 

www.elecard.com                                                                        10 
sales@elecard.com 
 

3. Using Elecard Video Quality Estimator 

3.1 Introduction 

The following section describes Elecard Video Quality Estimator GUI (graphical user interface). 

The Elecard Video Quality Estimator program has a simple user-friendly interface that allows the user 

to perform a number of operations including: opening 2 encoded streams and 1 raw stream for analysis, 

comparison and displaying the results of comparison along with basic parameters of the encoded 

streams. 

3.2 Describing Elecard Video Quality Estimator 

The following section describes Elecard Video Quality Estimator GUI. 

 

Figure 4. Elecard Video Quality Estimator GUI − Main Window 

3.2.1 ToolBars 

The following table describes Elecard Video Quality Estimator toolbars. 

Table 1. Elecard Video Quality Estimator GUI – Toolbars 

Menu item Button Description 

Video Quality Estimator 

About 

(application) 

 Shows information about the current application and supported formats 

Preferences  Opens the program settings dialog (Main, Binding, Save, License). 
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Quit 

(application) 

 Closes the application. 

File 

Open file  Opens media for analysis. 

Reopen  Opens the recently opened files. 

Reopen Last 

File 
 Reopens the last opened file. 

Close  Closes the files. 

Save  

Allows selecting parameters for saving and saves data: 

• stream parameters of the whole file (metrics info, index info, stream info) in a .csv 

file (file stores tabular data (numbers and text) in plain text. Each line of the file is a 

data record. Each record consists of one or more fields, separated by commas or 

semicolon); 

• current frame parameters (YUV data and image including A, B, RAW, Difference) 

as YUV or .png files. 

The saving parameters can be also configured in the Options tab. 

Binding  

Enables or disables the Binding mode: 

• Leader – allows sending comments, commands on interface or positioning 

changes to other applications; 

• Follower – allows receiving comments, commands from other applications.  

Open 

comments 
 Opens comments from the XML file. 

Save comments  Saves comments to the XML file. 

Open with 

 

Opens the current file with an external application (the application name and its path 

are set in the Open With List field by opening Options – Main. Player is set by 

default). 

View 

Color space  
Selects color space to be displayed: YUV, Y, U, V. 

Scale x1 Sets the video scaling coefficient: x0.25, x0.5, x1, x2, x4, x8. 

Grid  
Displays grid for convenience: none, 4x4, 8x8, 16x16, 32x32. 

ROI  /  
Region of interest (ROI) – limits analysis to the specified field: Normal / Inverse.  

Values of ROI: X: -1; Y: -1; W: -1; H: -1. 

Output  
Output – shows and activates the current window (A / B / RAW / Difference) 

Difference  

Enables/disables the comparison of Streams A and/or B with the Raw stream. The 

combo-boxes Difference Mode, Source 0, Source 1 are displayed. 

The following Difference modes are available: 

• Compare – pixel-by-pixel comparison of two frames. If two pixels are matched, the 

result is 0. Otherwise the result is equal to the maximum value.  

• Subtraction – pixel-by-pixel subtraction. The result is equal to the difference value. 

• Temperature – absolute difference (pixel-by-pixel subtraction), results are 

highlighted (black-blue-green-red), where black corresponds to zero difference, blue 

corresponds to slight difference, green corresponds to medium difference and red 

corresponds to the biggest difference.  

• PSNR – the result is the PSNR values (from 0 to 99.99) for corresponding CU 

partitioning blocks, where black color corresponds to 0 value, and white color 

corresponds to the value of 99.99 and higher. 

• PSNR Clip – the same as the PSNR, but minimum result value is the minimal PSNR 

among all blocks in the frame and maximum – the maximal PSNR, respectively. 

Black color corresponds to minimal value, white color corresponds to maximal 

value, and blended colors correspond to intermediate values.  

The following Source 0, Source 1 values are available: A, B, Raw. 
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Navigation 

Go to begin  
Go to beginning - sets the current position to the first frame in the stream. 

Step backward  
Previous - sets the current position to the previous frame. 

Play  
Play - starts and stops the stream playback. 

Step forward  
Next - sets the current position to the next frame.     

Go to end  
Go to end - sets the current position to the last frame in the stream. 

Offset  

Decrement / 

Increment 
   

Offset decrement / increment. Allows adjusting stream position relatively to others.  

File 
 

Allows choosing a stream: A, B, RAW. 

Help 

Feedback  
Sends the Video Quality Estimator feedback via e-mail with the following subjects: 

Submit an Idea, Ask a Question, Report a Bug. 

Contents  Opens the current User Guide in .pdf format 

Graphics 

Barchart 

Configuration  
Shows a stream type and frame size: None, Clustered, Overlapping, Bit Allocation, 

Quantizer, Graphics mode. 

Graphics  
Displays stream graphics: A-B, A-RAW, B-RAW  

Metric type PSNR 

Visualizes all metric types selected when opening streams in the New Task window: 

PSNR, APSNR, MSAD, MSE, SSIM, DELTA, VQM, NQI, VIF, VMAF and VMAF 

phone. None is displayed when no streams are selected.  

Color space  
Selects color space for display: YUV, Y, U, V. 

Horizontal 

range  
Adjusts graphics to the current panel size horizontally. 

Vertical range  
Adjusts graphics to the current panel size vertically. 

Zoom In / Out  /  
Scaling up and down. 

3.2.2 Graphics panel 

To open the Graphics panel, click the View tab and select Graphics. A dialog window will open. 

Graphics: 

 
Figure 5. Elecard Video Quality Estimator GUI − Graphics 

The Graphics panel displays the video streams being analyzed. The bar height illustrates the frame size 

and the bar color indicates the frame type (red – I, blue – P, green - B). The values displayed above the 

graphics correspond to minimum and maximum calculated values for the selected metrics of the 

component(-s). 
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To set the stream position to a frame, click the corresponding bar. 

The Bar Chart Configuration button  – allows configuring Bar Chart presentation mode to display 

additional information about the streams, including: frame size and type, bit allocation and quantizer: 

• None - is displayed when no configurations are selected. 

• Clustered – displays chart bars by A-B pairs under the corresponding display number; 

• Overlapping – displays overlapping (overlaid) chart bars showing variance between them;  

• Bit allocation – number of bits that are processed per a unit of time. 

• Quantizer – displays the frame mean Quantizer value. 

• Graphics mode – decreases chart bar brightness to focus attention on graphics. This option is 

switched on by default.  

To select stream graphics between A-B, A-RAW, B-RAW, click the  toolbar button and enable 

checkboxes. 

To see all the metric types selected for graphics displayed, click the Metric type tab . None is 

displayed when no metric types are selected. 

To choose the component which metrics will be displayed in graphics, click the  button and select the 

required streams. Click the  or  button to adjust the graphics to the reference window size 

horizontally or vertically, the minimal size is 1 pixel per frame. Click the  /  buttons for upscaling 

or downscaling the graphics. 

Hover a cursor over a frame, the frame metric info is displayed. 

 
Figure 6. Elecard Video Quality Estimator GUI − Frame Metric Information Window 

3.2.3 Stream Panel 

The Stream panel displays the current stream summary information: stream type, profile, compatibility 

flags, level, tier, chroma format, resolution, frame rate, declared bitrate, duration, epsnr, frame types, 

average frame size, range of quantizer values, bit allocation info, frame average bit distribution in CU, 

prediction and transformation data.  
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Figure 7. Elecard Video Quality Estimator GUI − Stream Panel 

3.2.4 Frame Panel 

The Frame panel displays the current frame summary information: stream / display number, type, sizes, 

qp. If A and B streams are open, information for both streams is displayed simultaneously for better user 

experience in analysis and comparison. The red color corresponds to the A stream, the blue color 

corresponds to the B stream. 

 
Figure 8. Elecard Video Quality Estimator GUI − Frame Panel 

3.2.5 Comments Panel 

The Comments panel is designed for team work: share comments on a specific frame or group of frames 

in the stream, navigation and switching between different instances of the same application or different 

applications contained in Elecard StreamEye Studio.  
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To edit, remove or send comments using the Binding mode, open the context menu by right-clicking. 

The Send option enables you to pass the selected comment to the other application of StreamEye Studio 

set or the other instance of Video Quality Estimator. To select an application from which messages should 

be received or to select a type of messages to be received, go to the Options tab – Binding. 

 
Figure 9. Elecard Video Quality Estimator GUI − Comments Panel 

3.2.6 New Task 

To open new media files for analysis and comparison, click the  button or click the File tab and select 

the corresponding menu item. A dialog window will open. 

Add the required streams to the File A, and/or File B and file RAW fields from the Open file dialog 

window by clicking the browse button or clicking the recently opened files button. Select the required 

parameter for the RAW file in a drop-down box. 

Select metrics by enabling the corresponding checkboxes.  

Enable checkboxes for ROI (region of interest), auto synchronization and start quality estimation after 

closing the dialog, if required. Specify ROI values and choose normal or inverse type of the analyzed 

area. Specify the frames range for auto synchronization mode.  
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Figure 10. Elecard Video Quality Estimator GUI − New task window 

Note: All input files should have the same resolution. If files differ in length, then the shortest length is 

taken for calculation: metrics are not calculated for the frames beyond the shortest file length. 

3.2.7 Options Dialog 

To configure file settings, binding and saving modes, open the Options dialog by selecting the 

Preferences menu command from the VideoQuest tab.  
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Figure 11. Elecard Video Quality Estimator GUI – Options – Main Tab 

The following table describes the Main tab in the Options dialog. 

Table 2. Elecard Video Quality Estimator – Options dialog – Main tab 

Control Function 

Number of recent files in list Shows a number of recent files being saved in a list. 

Delete missing recent files from 

list automatically 

Allows deleting missing files from the recent list automatically when opening a 

file from the list.  

Show Task dialog when reopen Allows reopening the task dialog with previously saved configurations. 

Always show Property dialog 

when opening a raw stream 

Enables/disables the Property dialog displaying when opening a stream. If the 

option is disabled, the stream is opened with the last used width, height, and 

type parameters. 

Use the native chroma format in 

metric calculation 
Allows specifying parser initialization buffer.  

Open With List 
Allows opening the file currently opened in Video Quality Estimator with 

another application (see details below). 

Set position from I frame 

Allows starting calculation from the first I frame in a stream. 

Note: Be aware of the fact that it overwhelmingly causes improper operation 

of positioning. You can use it only at your own risk and responsibility. 

The Options Dialog allows opening a file with an external application. To open the file currently opened 

in Video Quality Estimator with another application, specify its name and path in the Open with list 

field according to parameters specified there. The parameters path and shortcut are optional. If the path 

parameter is not specified, default application or player supporting a file format and installed in the 

system is opened. Each string specified in the Open with list field corresponds to an individual item in 

the menu File – Open with, that allows easy switching between applications or players after configuring 

the field. 
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Note: The Restore Defaults button allows you to reset set options to their original values. Functionality of this button 

is not applicable to the License tab. 

 
Figure 12. Elecard Video Quality Estimator GUI – Options – Visualization Tab     

The Visualizaion tab allows configuring the display of the application interface.  

By switching to the Dark Color Theme, the VideoQuest interface is displayed in the dark mode (by 

Default the light background is set).  

The Use different colors to display output option enables colorization of output values with different 

colors in the Frame and Stream panels. 
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Figure 13. Elecard Video Quality Estimator GUI – Options – Binding Tab 

The Binding tab contains settings that allow configuration of the interaction between Elecard StreamEye 

Studio applications. In the Binding Mode, exchanging information between applications is provided via 

a specified port. By activating checkboxes, you can select which applications should send messages and 

set messages type that should be communicated. Additionally, the synchronization of applications 

window size and switching between controls can be enabled. 
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Figure 14. Elecard Video Quality Estimator GUI – Options – Save Tab      

 

The following table describes the Save tab in the Options dialog. 

Table 3.  Elecard Video Quality Estimator – Options dialog – Save tab 

Control Function 

File data type 
Allows selecting the format in which metrics data should be saved (the CSV or 

JSON format). 

Decimal separator in .csv file 
Allows selecting decimal comma or decimal dot to separate an integer part from a 

fractional one of a real number. 

Data delimiter in .csv file Allows selecting comma or semicolon to specify boundaries in data stream. 

Add distribution info to Allows adding distribution info when saving a file: Stream info, Index info. 

Add metric info to Index file for 
Allows adding metric info for the selected parameters when saving: Y component, 

U component, V component or average value. 

Output YUV data type 

Allows saving YUV data in one of the following formats I444, I422, IYUV, NV12, 

NV21, P444, RGB24, RGB32, UYVY (Y422, UYNV, HDYC), V210, V400, 

V444, Y42B, YUY2 (YUNV, V422, YUYV), YV12, YV16. 
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3.2.8 Hot Keys 

For tabs, functions and modes switching press hot keys described hereto. 

• Ctrl + O     – opens a media file. 

• Ctrl + R – opens the recently opened file. 

The following hot key combinations are used for Navigation: 

• Ctrl + Shift + Left – starts the Go to beginning function. 

• Alt + Left – goes to the Previous frame. 

• Ctrl + Space – starts and stops the Play function. 

• Alt + Right – goes to the Next frame. 

• Ctrl + Shift + Right – starts the Gо to end function. 

To change View configuration of panel controls, use the following hot keys: 

• F2 – shows / hides all controls. 

• F3 – shows all (controls). 

For configuring information panels, use the following hot key combinations: 

• ALT+1 – shows / activates the stream A panel. 

• ALT+2 – shows / activates the stream B panel. 

• ALT+3 – shows / activates the frame panel. 

The following hot keys are used for switching Output Panels: 

• CTRL+1 – activates the A panel. 

• CTRL+2 – activates the B panel. 

• CTRL+3 – activates the RAW panel. 

• CTRL+4 – activates the Difference panel. 
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4. Command Line Tool 

Elecard Video Quality Estimator Command Line tool is designed for insight into MPEG-1/2, 

H.264/AVC, H.265/HEVC, H.266/VVC, VP9, AV1 and AVS3 video compression standards and ever 

fast quality and compliance check. 

Video Quality Estimator Command Line tool allows automatic analysis of video arrays. You can 

customize a sequence of commands to perform your specific tasks and automate your routine tasks. 

Get to the command prompt by clicking Start->Run and type 'cmd'. Then enter the command to start the 

application first and proceed with the command line options. In general, the syntax is as follows: 

./videoquest-cli config.xml /inA:input.avc /out:output_avc /ref:ref_input.yuv 

Note: You should not relocate the <product> console without all the other applications of the product 

contained in the installation pack, otherwise the console application will not start. 

4.1 Configuration File 

Configuration file – contains all the commands performed by the application and reflects overall 

operation results: 

 

<?xml version="1.0"?> 

<VQ version="1"> 

      <inputA file="…" stream="-1(default)" offset="0(default)"/> 

      <inputB file="…" stream="-1(default)" offset="0(default)"/> 

      <reference file="" type="IYUV(default)/[*Upsampler Type]" 

offset="0(default)" step="1(default)"/> 

      <output separator=".(default)/," delimiter=";(default)/," file="…"/> 

      <roi x="0" y= "0" width="0" height="0" inverse="true\false"/> 

      <sync window="0(default)" source="AB/ARaw/BRaw"/> 

      <range span="all(default)/start - stop"/> 

      <info> 

            <stream distribution="on(default)/off" file="…"/> 

            <index distribution="on(default)/off" file="…"/> 

<metrics data="All(default)|AB|ARaw|BRaw" 

nativeChroma="Yes(default)/No" component="All(default)|Y|U|V|A" 

type="PSNR(default)|APSNR|SSIM|… " file="…"/> 

            <data source="A|B" format="IYUV(default)/YV12" file="…"/> 

            <difference type="compare/subtraction/temperature/psnr/psnr clip" 

source="AB/ARaw/BRaw" format="IYUV(default)/YV12" file="…"/> 

            <message source="A|B" level="all(default)/message/warning/error" 

file="…"/> 

      </info> 

</VQ> 

 

4.2 List of Commands 

List of commands contains information on the commands and all parameters, which may be used within 

a command, and their description. 

 

 

Command Description 
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<input1/> 

<input2/> 

  

 

  stream 

 

  offset 

The tag is used to configure the input file; 

 

Specifies the elementary video stream number if number of streams exceeds one.  

«-1» — first available elementary video stream. It is set by default. 

Starting frame for further calculation. Offset from the beginning up to the specified frame in the 

stream. It is expressed in frames. 

<reference/> 

  type 

  

  file 

  offset 

   

  step 

The tag is used to configure the reference file; 

Defines the format of the raw data. (YV12 (is set by default) / IYUV are used now. More formats 

to be supported in the next updates.); 

Sets the path to the reference file. 

Offset from the beginning up to the specified frame in a reference stream. It is expressed in 

frames. “0” is set by default. 

Coefficient used for calculation of a successive frame number for further analysis. “1” is set by 

default. 

<output/>          

  separator 
   

  delimiter 
  file 

The tag is used to configure the output file; 

Allows selecting decimal comma or decimal dot to separate an integer part from a fractional one 

of a real number. 

Allows selecting comma or semicolon to specify boundaries in data stream. 

Sets the output file path. 

<roi/>          

  normal 

  inverse 

Region of interest selected for measurement;  

Measures the specified field of the frame; 

Measures the whole frame field except the specified part 

<sync/>          Specifies the frames range for auto synchronization mode. “0” is set by default. 

<range/> 

  span 

   

The tag is used to define the range of analyzed frames; 

Defines the range of frames (all (by default) /start - stop), 'start' - number of the first analyzed 

frame, 'stop' - number of the last analyzed frame. 

<stream/> 

  distribution 

  file 

The tag is used to output general information about the analyzed stream; 

Contains information on data distribution by type of coding units (on (by default) / off); 

Sets the path for the output stream information. 

<index/> 

   

  distribution 

  file 

The tag is used to output information about frames (offset, frame type, frame size, average 

quantizer, etc.); 

Contains information on data distribution by type of coding units (on (by default) / off); 

Sets the output file path where information on frames will be saved. 

<metrics/> 

  data 

   

  type 

  

  file 

The tag is used to output information on quality metrics; 

Specifies the type of the streams selected for metrics calculation and saving: All (by default) | AB 

| ARaw | BRaw; 

Specifies the metric type: PSNR (by default) | APSNR | SSIM | DELTA | MSAD | MSE | VQM | 

NQI | VIF | VMAF | VMAF phone. 

Sets the output file path where information on metrics will be saved. 

<data/> 

  source 

  format 

  file 

The tag is used to save output decoder information on any decoding step; 

Defines the type of the source for metrics calculation: A | B | Raw 
Defines the format for saving data (IYUV (by default)); 

Sets the output file path where the data will be saved. 

<difference/> 

  type 

 

   

   source 

   file 

The tag is used to output information on difference metrics 

Defines the type of difference (compare/subtraction/temperature/psnr/psnr clip). This is the 

required parameter for this tag. Its default value should be set. If the value is not set, this tag will 

be skipped; 

Specifies the source type for difference calculation: AB | ARaw | BRaw; 

Sets the output file path where information on difference will be saved. 
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4.3 Features of Command Line Tool 

⚫ Analysis the whole array of video files automatically; 

⚫ Addressing specific and complex challenges with a few lines of commands; 

⚫ Retrieving submitted results as a text file in CSV format for easy viewing in Excel; 

⚫ Customizing a sequence of commands to perform your specific tasks; 

⚫ Accelerating and automating your regular tasks. 

 


